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After completing this lesson, you will be able to:
1. Explore PowerPoint.

2. View a presentation.

3. Add text using placeholders.

4. Name and save a presentation.

5. Prepare presentation supplements.

6. End your work session.

MCAS OBJECTIVES

In this lesson:
PP07 4.3.6
PP07 4.4.2

See Appendix

OBJECTIVES

 Estimated Time: 2 hours

Lesson 1

Getting Started 
in PowerPoint

PP-6

PowerPoint is an easy-to-use presentation graphics program you can use to 
create professional-quality presentations. PowerPoint can be used in a variety 
of settings by people in many different career fields. For example, a day care 
worker may develop a presentation showing parents pictures of their children in 
all of the year’s activities, or a minister may utilize PowerPoint to display notes 
on the sermon or song lyrics for the congregation. An instructor may use it for 
notes for a lecture to help students keep focused and their notes organized, or 
a hotelier may develop a presentation to help market the hotel at conferences 
and meetings. PowerPoint is also an effective tool for creating flyers and other 
printed products because of its versatile drawing and layout tools.

This lesson begins with an overview of many PowerPoint features and 
will help you become accustomed to the application window.

Exploring PowerPoint
If you are already familiar with other Microsoft Office 2007 programs, you’ll 
feel right at home with PowerPoint. Although a number of new features 
appear in the PowerPoint window shown in Figure 1-1, it’s easy to recognize 
similarities to Microsoft Word and Microsoft Excel.

 OBJECTIVE 1 OBJECTIVE 1

TEACH
Teaching Resources:
This text is supported by Classroom 
Presentations in a PowerPoint format, 
an instructor’s manual, and a test 
bank. For this lesson, use PowerPoint 
Classroom Presentation 1.

PREPARE
Point out to students that the 
learning objectives show what 
they will learn in the lesson. Each 
heading in the lesson correlates 
to a learning objective.
Required Files: ThreeYr1.pptx

This book assumes that 
students have some basic 
familiarity with Windows 
applications.
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PP-7LESSON 1 Getting Started in PowerPoint

TABLE 1-1 Main Parts of the PowerPoint Window

Part of Window Purpose

Title bar Contains the name of the presentation.

Quick Access toolbar  Located by default at the top of the PowerPoint 
window and provides quick access to commands that 
you use frequently.

Microsoft Office Button  Located in the upper left-hand corner and contains 
commands to open, save, print, and share your 
PowerPoint file with others.

Ribbon  Consists of task-oriented tabs with commands 
 organized in groups.

Tabs  Task-oriented collections of commands. In addition to 
the standard tabs, there are other tabs which appear 
only when they are useful for the type of task you are 
currently performing.

Groups Logical sets of related commands and options.

Command buttons  Buttons designed to perform a function or display a 
gallery of options.

Slide pane  The area where you create, edit, and display 
presentation slides.

Notes pane  The area where you can add presentation notes for 
the presenter.

Slides and Outline pane  The area that can display either an outline of the 
 presentation’s text or thumbnails—miniature pictures—
of the presentation’s slides. You choose either Outline 
or Slides by clicking the appropriate tab. (If this pane is 
not displayed, click the Normal view button.)

Scroll bars  Used with the pointer to move a slide or outline text 
right or left and up or down. You can also use the 
vertical scroll bar to move from slide to slide.

Status bar  Displays information about the presentation you are 
working on.

View buttons  Buttons used to switch between Normal view, Slide 
Sorter view, and Slide Show view.

In PowerPoint Classroom 
Presentation 1c

c
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Figure 1-1
Main features in 

PowerPoint’s Normal 
view

Figure 1-2
ScreenTip over the 

Microsoft Office 
Button

Exercise 1-1  IDENTIFY PARTS OF THE 
POWERPOINT WINDOW

The first step to becoming familiar with PowerPoint is to identify the 
parts of the window. The Ribbon contains seven task-oriented tabs: Home, 
Insert, Design, Animations, Slide Show, Review, and View. Commands are 
organized in logical groups with command buttons and other controls. 
ScreenTips will help you identify command buttons and other objects. A 
ScreenTip is the box displaying an object’s name and sometimes a brief 
description that appears under a command button or other object when 
you point to it. Within the Ribbon groups are drop-down galleries that 

easily present formatting options, graphics 
choices, layouts, and more.

 1.  Using Figure 1-1 as a guide, move 
your pointer over items in the 
PowerPoint window to identify them 
by name using ScreenTips similar to 
Figure 1-2.

Exercise 1-2  USE THE QUICK ACCESS TOOLBAR

The Quick Access toolbar is a customizable toolbar containing a set of 
common commands that function independently of the tab that is currently 
displayed. This toolbar’s default location is above the Ribbon. It can be 
moved under the Ribbon, but this location requires more space.

Title bar

Ribbon  

Slide pane

Notes pane

View buttons
Status bar

Outline and 
Slides pane

Microsoft 
Office Button Quick Access 

toolbar

Tabs

Command 
buttons Groups

To display a ScreenTip, remind students they must point to the 
button and hold the pointer still. PowerPoint does not display 
tips unless the mouse has not moved for a second or so.

c

c In PowerPoint Classroom 
Presentation 1

c
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 1. Click the drop-down arrow at the end of the Quick Access toolbar.

 2. Choose Show Below the Ribbon. 

 3. Click the drop-down arrow again and choose Show Above the Ribbon 
to return to the default position.

Exercise 1-3  OPEN AN EXISTING PRESENTATION

When you first open PowerPoint, a new blank presentation automatically 
appears, ready for you to add text and graphics. However, in this exercise you 

open an existing PowerPoint presentation. The presentation 
was created for this lesson to give you an overview of many 
PowerPoint features. 

 1.  Point to the Microsoft Office Button  and 
click the left mouse button to open a menu.

 2.  Choose Open.

 3. In the Open dialog box, navigate to the appropriate drive and folder 
for your student files according to your instructor’s directions.

 4. When you locate the student files, click the arrow next to the Views 
button  (see Figure 1-3) in the Open dialog box to display a 
menu of view options.

Figure 1-3
Folders listed in the 

Open dialog box

Views 
button

NOTE

When downloading student data files 
online, data files are zipped. You must 

right-click this folder and extract all files 
before moving on with Exercise 1-3.

c

You might want to review the Open dialog box buttons. 
You might also want to review the links under my favorite 
links (Desktop, Computer, Documents, Music, Recently 
Changed, and Searches). These buttons are helpful for 
locating and viewing files. The same buttons appear in 
the Save As dialog box. If you have loaded all student 
files into a folder on a hard disk or network, you might 
want to show students how to place this folder in the 
Documents list for easy access.

In PowerPoint 
Classroom 
Presentation 1

c Make sure students know where files 
for this course are located. You can 
load student files on a hard disk or 
on a network. If this has not already 
been done, you may load the files from 
the student disk to a location where 
the students can access them, or 
they can load them from the CD that 
accompanies the text.
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 5. Choose Small Icons to list all files by name.

 6.  Click the Views button  again and choose 
Details to see the type of file and the date when it 
was last modified.

 7.  Locate the file ThreeYr1 (use the scroll bar if you 
need to) and click once to select the file.

 8.  Click Open. (You can also double-click the file’s name 
to open it.) PowerPoint opens the file in Normal view.

NOTE

Your instructor will advise you where to 
locate the files for this course. For more 

information about working with files, 
folders, and directories in Windows, refer 
to “File Management” at the Professional 

Approach Online Learning Center at 
www.mhhe.com/pas07brief.

NOTE

 The presentations you create in this 
course relate to the case study at the 
front of this text about Good 4 U, a 

fictional restaurant.

Exercise 1-4  WORK WITH RIBBONS, TABS, 
GROUPS, AND COMMAND BUTTONS

PowerPoint organizes command buttons in a logical way. On the Ribbon, 
the tabs reflect tasks or activities you commonly perform and provide easy 
access to the commands. Within each tab, the commands are divided into 
related groups of buttons and other controls.

Live Preview is a feature that allows you to see exactly what your changes 
will look like before clicking or selecting an effect. Sometimes the available 
effects are presented in a gallery that displays thumbnails of different options 
you can choose.

 1. Click the Insert tab on the Ribbon.

 2. Identify each of the groups located on the Insert tab: Tables, 
Illustrations, Links, Text, and Media Clips.

 3. These groups each contain command buttons that either provide 
options through dialog boxes or through galleries of options.

Exercise 1-5  USE MICROSOFT OFFICE 
POWERPOINT HELP

Microsoft Office provides a Help feature that is an excellent reference tool 
for reinforcing skills presented in a lesson and for finding more information 
on any PowerPoint feature. Each program in Microsoft Office has a separate 
Help window.

The presentation name might appear as 
“ThreeYr1[Read Only]” in the title bar. Explain 
to students the purpose of this read-only 
protection (to preserve the original file). Make 
sure this protection is applied to all loaded 
student files.

Point out that some command 
buttons appear dimmed or 
gray. For example, the Cut 
button is dimmed unless 
something is selected.

Encourage students to follow the 
steps in “Using Help.” Software 
companies are increasingly using online 
help systems—rather than printed 
documentation—to train users and 
assist in answering user questions.
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 1.  Click Microsoft Office PowerPoint Help button  
located on the upper-right of the Ribbon or you can 
press F1. The Help window will appear on top of 
your open PowerPoint presentation.

 2.  Key Ribbon in the search box located on the Help 
window, and then press Enter .

 3.  Scroll through the list of options that display and 
select Use the Ribbon.

 4.  Read and scroll through the entire Help window.

 5.  When you have finished, click the Close button  in the upper-
right corner of the Help window to close it and return to PowerPoint.

Viewing a Presentation
PowerPoint provides multiple views for working with your presentations. 
Using these various views, you can work in outline format, rearrange slides 
in Slide Sorter view, or work on an individual slide in the Slide pane of 
Normal view. 

Exercise 1-6  USE NORMAL AND SLIDE 
SORTER VIEWS

The Normal view is the best for entering text directly on a slide and planning 
the design of your presentation. Normal view is the default view when you 
open PowerPoint. The Slide Sorter view presents a window of slide thumbnails, 
which are miniature versions of the slides. To rearrange slides, you can click 
on a thumbnail and then hold down the left mouse button while you drag it 
to a new position. Slide Sorter view makes it easy to apply special slide-show 
effects.

 1. From the View tab, in the Presentation Views group, choose the 
Slide Sorter button .

 2. Click and drag slide 7 to place it before slide 6. You will be able to tell 
where your slide is when dragging by the vertical line that appears.

 3. From the View tab, in the Presentation Views group, choose the 
Normal button  to return to Normal view.

Exercise 1-7 USE THE SLIDES AND OUTLINE PANE

In Normal view, the Slides and Outline pane is at the left of the Slide pane. It 
provides some alternative ways to work with your presentation. The Outline 
tab shows only slide titles and listed text with bullets, small circular shapes, 
in front of each listing. The Outline tab allows you to enter just your text 
content as an outline without modifying the design or adding graphics to 

 OBJECTIVE 2 OBJECTIVE 2

NOTE

If you are connected to the Internet, 
Help will automatically open a browser 
and search your topic. If this happens, 
you will have to close the browser and 

the Help window.

In this exercise students are asked to drag a screen 
element. If students are unfamiliar with dragging, you 
might take this opportunity to demonstrate how to drag 
an element and ask students to practice.

Talk about the possibilities and benefits of using Slide Sorter. Explain 
why you might want to use the Slide Sorter view, for example, to 
preview each slide in sequence, to get a snapshot of the entire 
presentation, and to move or rearrange slides.
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your slide. The Slides tab provides thumbnails 
similar to the Slide Sorter view.

 1.  Click the Outline tab at the top of the Slides 
and Outline pane. The Outline pane displays 
the presentation’s text in an outline format.

 2.  Point to the right border of the Slides and 
Outline pane. When the splitter  appears, 
drag the border about an inch to the right. 
This increases the size of the Slides and 
Outline pane.

 3.  Scroll in the outline text until you see the 
text for slide 4.

 4.  Working in the Outline tab, change each of 
the years (06, 07, and 08) to 2007, 2008, and 
2009. The first line, for example, should 
read Miami in 2007. Notice that as you 
work, your changes are reflected in the 
Slide pane.

 5.  Click in front of Miami, then from the Home tab, in 
the Paragraph group, choose the Decrease List Level 
button  to promote the item by moving it to the 
left. Apply this same treatment to Los Angeles in 
2008 and Five Restaurants by 2009. This 
distinguishes the main items in the list from the 
more detailed items under them.

 6. Click the Close button  on the Slides and Outline pane to hide it. 
The Slide pane expands to fill the space.

 7. From the View tab, in the Presentation Views group, choose the 
Normal view button . The Slides and Outline pane is displayed 
again.

 8. Click the Slides tab at the top of the Slides and Outline pane. The 
Slides and Outline pane becomes smaller and the size of the Slide 
pane increases.

Exercise 1-8 MOVE FROM SLIDE TO SLIDE

PowerPoint provides several ways to move from slide to slide in a 
presentation:

• Use the pointer to drag the scroll box.

• Use the pointer to click the Previous slide  or Next slide  buttons.

• Use the Page Up  and Page Down  keys on the keyboard.

Figure 1-4
Working with the 
Slides and Outline 

pane
Close button

Scroll bar

Splitter bar

NOTE

When you have several bulleted lists, you 
can key them all in outline format if that’s 

the way you like to work.

Outline and Slides tabs

In PowerPoint Classroom 
Presentation 1c

c
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 1. Drag the vertical scroll box on the Slide pane to the bottom of the 
scroll bar. Notice the box that displays slide numbers and slide titles 
as you drag. When you release the mouse button at the bottom of 
the scroll bar, slide 7 appears in your window. Notice slide 7 has a 
highlighted border around it in the Slide pane. This identifies it as 
the current slide.

 2. Drag the scroll box up to display slide 6. Notice that Slide 6 of 7 is 
indicated on the left side of the status bar.

 3. Click the Previous Slide button  at the bottom of the vertical scroll 
bar several times to move back in the presentation. Use the Next 
Slide button  to move forward.

 4. As an alternative to clicking the Next Slide button  and the 
Previous Slide button , press Page Down  and Page Up  on your keyboard 
several times. Use this method to move to slide 2. Check the status 
bar for the slide number.

Exercise 1-9 USE THE ZOOM AND FIT TO WINDOW

PowerPoint provides two different ways to zoom and Fit to Window. Zoom is 
a great tool for magnifying your slide so you can see small details for precise 
alignment and corrections. The Fit to Window command will change from 
the current zoom settings to fit in the window that is open.

Figure 1-5
Moving from slide 

to slide

Slide number 
indicator

Screen Tip displaying 
slide number and title

Vertical scroll bar

Previous Slide button

Next Slide button

c

In PowerPoint Classroom 
Presentation 1c Another way to move from slide to slide is to click above or below the 

scroll box on the vertical scroll bar or use the left and right arrow keys.
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• From the View tab, in the Zoom group, choose the Zoom or Fit to 
Window command buttons.

• Use the Zoom slider and Fit to Window buttons on the right end of the 
status bar.

 1. From the View tab, in the Zoom group, click the Zoom button .

 2. On the Zoom dialog box, click the Radial button beside 200% and 
click OK. You can use the zoom feature in Normal or Slide Sorter 
view to change the percentage of what you are viewing.

 3.  On the right end of the status bar is a Zoom slider. 
Click the Zoom out button (a minus)  until you 
reach 170%.

 4.  From the View tab, in the Zoom group, choose the Fit 
to Window button . This reduces the size of your 
slide to be viewable in the window.

Exercise 1-10 RUN A SLIDE SHOW

A slide show displays slides sequentially in full-screen size. One way to start 
a slide show is to click the Slide Show command button. After you begin 
running a slide show, PowerPoint provides navigation tools to move from 
slide to slide. You may start a slide show from any slide by moving to the 
slide you wish to start on and clicking the Slide Show command button.

 1.  Move to slide 1 if it is not currently displayed. Click 
the Slide Show button  located on the status bar 
to the left of the Zoom slider. The first slide in the 
presentation fills the screen.

 2.  Click the left mouse button to move to slide 2. The 
left mouse button is one of many ways to move 
forward in a slide presentation.

 3.  Press N  on the keyboard to move to the next slide, 
slide 3.

Exercise 1-11 OBSERVE ANIMATION EFFECTS

Animation effects are the special visual or sound effects used as objects are 
displayed on the screen or removed from view. Transition effects are the 
effects seen in the process of changing between slides.

TIP

You can also click and drag the Zoom 
slider toward the minus to zoom out and 

toward the plus to zoom in.

TIP

As an alternative to clicking the left 
mouse button, you can press the 

Spacebar  to move forward. Also, you can 
press N , which means “next” to move 

forward and P , which means “previous” 
to move backward. You can also use the 

right and left arrow keys or Page Down  and 
PageUp  to move forward and backward.

Zoom values will not necessarily be the same as shown 
in this and other figures. When the Fit to Window zoom 
setting is chosen, the percentage displayed in the Zoom box 
will vary depending on the size of your monitor, its screen 
resolution, and the number and size of the various panes 
currently displayed.

At this point in the lesson, you might want to engage students in a 
discussion about real-life uses for presentations. Gather from your 
class a list of outside activities, such as clubs, organizations, and 
cultural groups to which students belong. Discuss how they can 
use PowerPoint to make presentations for these groups or for their 
employers.
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 1. Press N  again to move to slide 4, which is titled “Where We’re 
Going.”

 2. Using the left mouse button, click anywhere to see a sample of a 
PowerPoint text animation. Click twice more to see the remaining 
text on this slide.

 3. Press N  again to move to slide 5. Notice the Box Out transition effect 
between slides 4 and 5.

 4. Click the left mouse button two times to bring in the text from 
slide 5.

 5. Press N  to move to slide 6. Press N  three more times to bring in the 
text for slide 6. Notice the Entrance and Emphasis effects placed on 
this text. If your sound is on, you should also hear sound effects with 
each text item.

 6. Press N  to move to slide 7 and N  again to finish the presentation.

 7. Press Esc  or –  (minus) to end the slide show.

Adding Text Using Placeholders
Adding and editing text in PowerPoint is very similar to editing text in 
a word processing program. You click an I-beam to position the insertion 
point where you want to key new text. An I-beam is a pointer in the shape 
of an uppercase “I.” An insertion point is a vertical blinking bar indicating 
where the text you key will be placed. You can also drag the I-beam to select 
existing text. The keys Enter , Delete , and Backspace  work the same way as in a 
word processing program.

It is important to understand that you activate a placeholder when you 
click the I-beam in it, making it ready to accept text.

Exercise 1-12 KEY PLACEHOLDER TEXT

Text on the slide is contained in text placeholders. Placeholders are used for 
title text (the text that usually appears at the top of a slide), body text (text in 
the body of a slide), and other objects, such as pictures. Placeholders help 
keep design layout and formatting consistent within a presentation.

Body text often contains bullets (small dots, squares, or other symbols) to 
indicate the beginning of each item in a list; therefore, this text is sometimes 
called bulleted text. Bullets can be decorative, also, for an attention-getting 
effect.

 1. Move to slide 2, click in the Title text placeholder to activate the 
placeholder. Notice the box that surrounds the text. The border is 
made up of tiny dashed lines, and sizing handles indicates that the 
text box is activated and in edit mode, meaning you can edit and 
insert text.

 OBJECTIVE 3 OBJECTIVE 3
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 2. Key the text Where We Came From.

 3.  Click anywhere on the line of text that begins “Gus 
Irvinelli.”

 4.  Without clicking, move the pointer outside the 
border to the right and then back inside.

 5.  Drag the I-beam across the text “an avid” to select it 
as shown in Figure 1-6. (Click to the left of “an 
avid,” hold down the left mouse button, drag the I-
beam across the two words, and then release the 
mouse button.)

NOTE

 Notice that the pointer changes from an 
I-beam  inside the border to an arrow 

pointer  outside the border. When 
the pointer rests on top of the border, it 
becomes a four-pointed arrow , which 

can be used to move the text placeholder. 
When the pointer rests on top of a sizing 

handle, a two-pointed arrow appears.

 6.  Key a professional to replace the selected text. (You 
don’t need to delete selected text before keying new 
text.)

 7.  Click the I-beam to place the insertion point to the 
right of the words “healthy eating,” near the bottom 
of the slide.

 8.  To insert a new line, press Enter . Notice that a new 
dimmed bullet appears at the beginning of the new 
line.

 9. Key Make their financial investment grow on the new blank bullet line.

 10. Click a blank part of the slide area to deactivate the text box. To 
make sure you are clicking a blank area, click when the pointer is a 
simple arrow, not an I-beam or a four-pointed arrow.

Figure 1-6
Selecting text to 

edit it

NOTE

Bulleted text lists the points being made 
in a slide presentation. This presentation 

uses open circle and solid dot bullets. 
Bullets can be changed to fit your 

presentation needs.

Emphasize to students that if they 
click when they see an I-beam, 
they activate a text placeholder (or 
text box) for editing. To deactivate 
a text placeholder, click outside the 
text placeholder—when the pointer 
is a white arrow.

Students might be unfamiliar with the process of 
dragging the I-beam to select text. You might take 
this opportunity to demonstrate how to do this 
and ask the students to practice. If necessary, 
refer students to the “Windows Tutorial” at the 
Professional Approach Online Learning Center at 
www.mhhe.com/pas07brief.

In PowerPoint Classroom 
Presentation 1c

c
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Exercise 1-13  CHANGE AND RESET 
PLACEHOLDER LAYOUT

Placeholders can be moved, resized, and rearranged on your slide. The layout 
feature of PowerPoint can be used to choose different layouts or reset the 
placeholder back to the original.

 1. Still working on slide 2, click in the Title placeholder to activate it.

 2. Move your pointer to the outer border of the Title placeholder.

 3. When your pointer turns to a four-pointed arrow  (see Figure 1-7), 
click and drag the Title placeholder to the bottom of the slide.

Figure 1-7
Selecting a 
placeholder

 4. From the Home tab, in the Slides group, click the Layout command 
button , and choose the Title and Content Layout to reposition the 
placeholders to their original position.

Naming and Saving a Presentation
In PowerPoint, presentations are saved as files. When you create a new 
presentation or make changes to an existing one, you must save the 
presentation to make your changes permanent. Until your changes are saved, 
they can be lost if there’s a power failure or a computer problem.

The first step in saving a document is to give it a filename. Filenames can 
be up to 255 characters long.

Throughout the exercises in this book, your document filenames will 
consist of two parts:

• The number of the exercise, such as 1-15.

• Your initials, which might be your initials or an identifier your 
instructor asks you to use, such as rst.

 OBJECTIVE 4 OBJECTIVE 4

Although a filename can be 255 characters long, you 
might want to point out that students should not use 
more than 20 characters and that their filenames 
should be meaningful and easy to find.

In PowerPoint Classroom 
Presentation 1c

c

  Objective 4 Assignment:
Exercises 1–20 (Skills Review) 
can be assigned after completing 
Objective 4.
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When you’re working with an existing file, choosing the Save command (or 
clicking the Save button  on the Quick Access toolbar) replaces the file 
with the file on which you’re working. After saving, the old version of the file 
no longer exists and the new version contains all your changes.

You can give an existing presentation a new name by using the Save
As command. The original presentation remains unchanged and a second 
presentation with a new name is saved as well.

Exercise 1-14  CREATE A FOLDER FOR SAVING 
YOUR FILES

Before saving a file, you need to decide where you want 
to save it: in a folder on your fixed disk drive, on a jump 
drive, floppy disk or other removable medium, or on a 
network drive.

When you save a file, it’s a good idea to create separate 
folders for specific categories to help keep your work 

organized. For example, you might want to create folders for different 
projects or different customers. In this course, you will follow these steps to 
create a new folder for each lesson’s work before you begin the lesson.

 1.  Click the Microsoft Office Button , choose Save 
As then PowerPoint Presentation. The Save As dialog 
box appears.

 2.  Using the list box at the top or links on the left, 
follow your instructor’s directions to navigate to the 
location where you should create your folder. If you 
will be using a jump drive or other media, put it in 
your computer’s drive now.

 3.  Click the Create New Folder button  on the Save As dialog 
box toolbar as shown in Figure 1-8.

NOTE

Your instructor will advise you of the 
proper drive or folder to use when 

creating your lesson folders.

Figure 1-8
Creating a new 

folder in the Save As 
dialog box

NOTE

Even though you clicked Cancel to close 
the Save As dialog box, your new folder 
has been created. You could have saved 

your presentation before closing the Save 
As dialog box, but you will do that in the 

next exercise instead.

Create New 
Folder button

Current folder

Throughout the text, students are told to save their 
files using the exercise number and their initials. 
If using initials presents a problem (if, for example, 
students with the same initials save files in a shared 
folder on a hard drive), assign a unique identifier to 
each student saving files within a particular folder.

You will need to tell students which 
drive/folder to use to save their files.

Emphasize the difference 
between Save and Save 
As. This concept is very 
important for students who 
are new to computers.
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 4.  With the words New Folder selected, key Lesson 1 and click off of the 
folder. A yellow folder icon with the name “Lesson 1” appears.

 5. Click Cancel to close the Save As dialog box.

Exercise 1-15  NAME AND SAVE A PRESENTATION

 To name files, you can use uppercase letters, lowercase letters, or a 
combination of both. Filenames can also include spaces. For example, you 
can use “Good 4 U Sales Report” as a filename.

 1. Click the Microsoft Office Button , choose Save As to reopen the 
Save As dialog box.

 2. Navigate to the drive and folder where you created your new Lesson 1 
folder.

 3. Double-click the Lesson 1 folder to open it.

 4. In the File name text box, key [1-15your initials].

 5. Click Save. Your document is saved and named for future use. Notice 
that the title bar displays the new filename.

Preparing Presentation Supplements
Although the primary way of viewing a presentation is usually as a slide show, 
you can also print PowerPoint slides, just as you print Word documents or Excel 
worksheets. PowerPoint provides a variety of print options, including printing 
each slide on a separate page or printing several slides on the same page. You 
should utilize the PowerPoint Print Preview option when preparing to print.

Throughout this course, to conserve paper and speed up printing, you 
usually print a handout instead of full-size slides. A handout contains several 
scaled-down slide images on each page (one, two, three, four, six, or nine to a 
page) and is often given to an audience during a presentation.

Exercise 1-16 PREVIEW A PRESENTATION

The PowerPoint Print Preview feature lets you see what your printed pages 
will look like before you actually print them. You can view preview pages in 
black and white, grayscale, or color.

 1. Click the Microsoft Office Button .

 2.  Point to the arrow next to Print.

 3. Click Print Preview. The Preview window opens, showing you how 
the printed slide will appear on paper. The Print Preview Ribbon 
(see Figure 1-9) is displayed at the top of the window.

 OBJECTIVE 5 OBJECTIVE 5

Figure 1-9
Print Preview Ribbon

c
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 4. From the Print Preview tab, in the Preview group, click the Next 
Page button . Page 2 of the printout is displayed.

 5. Move your pointer to the middle of the slide. Notice that the pointer 
is in the shape of a magnifying glass .

 6. Click the magnifying glass pointer in the center of the slide. The 
display is magnified.

 7. Click again. The display returns to its regular size.

 8. Click the Close the Print Preview window button .

Exercise 1-17  PRINT A SLIDE, NOTES PAGE, 
OUTLINE, AND HANDOUT

You can start the printing process in one of the following ways:

• Click the Microsoft Office Button , point to the arrow next to Print, 
and choose Print Preview. From the Print Preview Ribbon, in the Print 
group, click the Print button .

• Click the Microsoft Office Button, and choose Print.

TABLE 1-2 Print Preview Ribbon Buttons

Toolbar Button Name Purpose

 Print Open the Print dialog box.

 Options  Choose from a variety of options and preview them before 
printing.

 Print what  Choose between printing slides, handouts, notes pages, or 
an outline.

 Orientation  Switch the pages between portrait (vertical) and landscape 
(horizontal) layouts.

 Zoom Change the magnification in the Preview window.

 Fit to window  Zoom the presentation so that the slide fills the window.

 Next page Display the next page to be printed.

 Previous page Display the previous page to be printed.

 Close Print Preview Close the Print Preview window and return to Normal view.

In PowerPoint Classroom 
Presentation 1c
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• Press Ctrl � P .

• From the Quick Access toolbar, click the Quick Print button .

The first method opens the Print Preview window, which you learned in 
Exercise 1-16. The next two methods open the Print dialog box, where you 
can choose printing options. The last method, Quick Print , should be used 
with caution. You must first customize the Quick Access toolbar to make the 
button available. This feature prints a presentation with the most recently 
used print options and does not open the Print Options dialog box. Usually 
this will result in printing your entire presentation with one slide on a page.

Printing an outline view is a nice feature if you want to print text only 
and avoid the slide thumbnails. Printing notes pages allows the speaker to 
record notes and print them along with an image of the slide. Printing several 
slides on a single page is a handy way to review your work and to create 
audience handouts. It’s also a convenient way to print class assignments. You 
can create handouts in the Print Preview window or in the Print dialog box.

 1. To print the first slide in your presentation, display slide 1, click 
the Microsoft Office Button , and then choose Print. The Print 
dialog box displays PowerPoint’s default settings and indicates the 
designated printer as shown in Figure 1-10.

Figure 1-10
Print dialog box

 2.  At the top of the Print dialog box, click the down 
arrow in the Name box. This is where you choose 
another printer, if one is available. Follow your 
instructor’s directions to choose an appropriate 
printer from the list.

 3. In the Print range option box, choose Current Slide.

 4.  From the Print what drop-down list box, choose Slides.

NOTE

The information below the Name box 
applies to the selected printer. For 

example, “Status” indicates if the printer is 
idle or currently printing other documents.

Remind students to use Quick Print with caution. It uses the last chosen print 
options and usually prints a complete presentation with one slide on a page. 
This can consume lots of ink or toner and paper.
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 5. Click OK to start printing.

 6.  Click the Microsoft Office Button , point to the 
arrow next to Print, and choose Print Preview. From 
the Print Preview tab, in the Page Setup group, click 
the arrow next to the Print what list box and then 
choose Handouts (2 Slides per page). Only one slide is 
shown in Print Preview due to previous exercise 
choice of current slide only. To see both slides, return 
to the Print dialog box and choose All under Print 
Range. This screen displays how your handouts 
would look if printed with the selected options.

 7.  Still working in the Page Setup group, click the 
Orientation button  and choose Landscape.

 8.  Open the Print what list box and then choose Outline 
View  (this provides text only).

 9.  Open the Print what list box and then choose Notes 
Pages (this provides a snapshot of the slide as well 
as speaker notes).

10.  Open the Print what list box again and choose 
Handouts (9 Slides per page). Now the entire 
presentation is displayed on one page.

11.  From the Print Preview tab, in the Preview group, 
click the Close Print Preview button .

Exercise 1-18 CHOOSE PRINT OPTIONS

In addition to the options covered previously, there are two options for 
printing in black and white. The Grayscale option converts the presentation 

colors to shades of gray. The Pure Black and White option 
converts all colors to either black or white, eliminating 
shades of gray. Multiple copies can be printed, too, and the 
Collate option will print the slides in sequence.

The Print dialog box is divided into several areas: 
Printer, Print range, Copies, Print what, and Handouts. 
Each area presents choices that let you print exactly what 
you want in a variety of layouts.

 1.  Still working in 1-15your initials, click the 
Microsoft Office Button  and choose Print to open 
the Print dialog box.

 2.  Under Print range, click Slides and key 1,2 in the text 
box to print only slides 1 and 2.

 3.  Under Copies, in the Number of copies box, key 2. 
The Collate check box is selected by default to print 
the slide show from beginning to end two times.

TIP

You can create a presentation that uses 
overhead transparencies by printing 

your slides on transparency film. Before 
printing, insert transparency sheets 

directly into your printer (choosing the 
correct type of transparency for a laser or 

ink-jet printer).

TIP

If two slides are not displayed in the Print 
Preview screen, click the Print button, and 
under Print range, choose All. In the Print 
what drop-down list, choose Handouts. 

Then, under the Handouts heading, 
choose 2 from the drop-down list. Last of 
all, click Preview to return to Print Preview. 
This reverses the action where you chose 

Current Slide.

NOTE

Because the Pure Black and White option 
simplifies your presentation graphics, it 
can sometimes speed up printing time.

TIP

To print consecutive slides, you can use 
a hyphen. For example, key 2-4 to print 

slides 2 through 4. To print a combination 
of slides, you can key the range 1,3, 5-9, 

12 to print slides 1, 3, 5 through 9, and 12.

The Grayscale setting optimizes the look of color slides for printing on a black-and-white printer and saves color ink to cut costs.
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 4.  From the Print what drop-down list box, choose Notes Pages.

 5. If you have a black-and-white printer, choose Grayscale from the 
Color/grayscale list box. If you have a color printer, you can choose 
Color from the list box but the grayscale will conserve your colored 
ink/toner.

 6. Click the Scale to fit paper check box to expand items to the full width 
of the page.

 7. Click OK. 

 8. Open the Print dialog box again and set the following options:

 • For Print range, choose All to print all slides.

 • For Number of copies, key 1.

 • In the Print what list box, choose Handouts.

 • Under Handouts, choose 3 Slides per page.

 • From the Color/grayscale list box, choose Pure Black and White.

 • Click the Frame slides check box if it is not already checked.

 9.  Click OK to print the presentation handout and close the Print 
dialog box.

10.  Click the Microsoft Office Button , and choose Save As.

11. In the File name text box, key [1-18your initials].

12.  Click Save. Your document is saved and named for 
future use. Notice that the title bar displays the new 
filename.

Ending Your Work Session
After you finish working on a presentation and save it, you can close it and 
open another file or you can exit the program.

To close a presentation and exit PowerPoint, you can:

• Click the Microsoft Office Button  and choose Close or Exit 
PowerPoint.

• Use keyboard shortcuts. Ctrl �W  closes a presentation and Alt � F4  exits 
PowerPoint.

• Use the Close button  in the upper-right corner of the window.

 OBJECTIVE 6 OBJECTIVE 6

NOTE

You are still on landscape orientation 
since you set that in a previous exercise.

To save printing time and paper, students are 
instructed to print handouts throughout this 
course instead of full-page slides (unless they 
are being taught other print options).

  Objective 6 Assignment:
Exercises 1-21 through 1-23 (Skills Review), 
1-24 through 1-27 (Lesson Applications), 
1-28, 1-29, and 1-30 (On Your Own) can be 
assigned after completing Objective 6.
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Exercise 1-19  CLOSE A PRESENTATION 
AND EXIT POWERPOINT

 1. Click the Microsoft Office Button .

 2. Choose Close to exit the presentation.

 3. Click the Close button  in the upper-right corner of the window 
to exit PowerPoint.

Lesson Summary

• Microsoft PowerPoint is a powerful graphics program used to create 
professional-quality presentations for a variety of settings.

• Identify items in the PowerPoint window by pointing to them and 
waiting for their ScreenTips to appear.

• PowerPoint command buttons are arranged in groups that can be 
accessed by clicking tabs on the Ribbon.

• The Quick Access toolbar contains a set of commands independent of 
the tab that is currently displayed. The toolbar includes commonly used 
commands such as save, undo, redo, and print.

• PowerPoint Help window is a great place to look for additional 
information on a topic or steps to completing a task.

• Key and edit text on a slide in the same way as you would in a word 
processing program.

• Use the Slide Show button to run a slide show. A slide show always 
starts with the slide that is currently selected.

• To print handouts that contain more than one slide on a page, use the 
Print dialog box or Print Preview window to select from the Print what 
options.

• Printing options provide a variety of ways to print your presentation: as 
slides, handouts, notes pages, and outline view.

1

Encourage students to use the Lesson 
Summary to review the important 
concepts in the lesson.

The Close buttons are the easiest 
way to close a presentation or 
exit the program.

Point out that the Command Summary 
lists a variety of ways to accomplish a 
specific task. Students can decide which 
method they prefer.
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LESSON 1 Command Summary

Feature Button Ribbon Keyboard

Open a presentation  Microsoft Office Button, Open Ctrl � O

Display Slides and  View tab, Presentation Views group, Normal
Outline pane

Zoom  View tab, Zoom group, Zoom

Help  Help button F1

Normal view  View tab, Presentation Views group, Normal

Slide Sorter view  View tab, Presentation Views group, 
   Slide Sorter

Next Slide   PageDown

Previous Slide   Page Up

Slide Show  View tab, Presentation Views group,  F5

   Slide Show 

Save  Microsoft Office Button, Save; Ctrl � S

   Quick Access toolbar, Save button

Save with a different   Microsoft Office Button, Save As
name

Next Slide   Right-click, Next N , Page Down

(Slide Show view)

Previous Slide   Right-click, Previous P , Page Up , 
(Slide Show view)     Backspace  

End a slide show   Right-click, End Show Esc  or –

Layout  Home tab, Slides group, Layout

Print Preview   Microsoft Office Button,  Print arrow, 
   Print Preview

Print  Microsoft Office Button, Print; Ctrl � P

   Quick Access toolbar, Quick Print button

Close a presentation   Microsoft Office Button, Close Ctrl �W  or 
    Ctrl � F4

Exit PowerPoint  Microsoft Office Button, Exit PowerPoint Alt � F4

Review keyboard combinations with students. Make 
sure they master this skill and understand how it will be 
represented in this text.
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